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General Information

What is Aspect Pressure Vessel? 
Aspect Pressure Vessel (formerly PV Elite) is software for designing and analyzing 
pressure vessels and heat exchangers and assessing fitness for service. 

Who uses Aspect Pressure Vessel?  

Aspect Pressure Vessel is used across many industries by EPC contractors, 
fabrication shops, and vessel/exchanger owner-operators. It is also widely used by 
Notified Bodies for approving and verifying calculations to provide the necessary 
certification so the vessel can be put into operation. 

Why is Aspect Pressure Vessel used?  

Content: Pressure vessels are complex equipment, often under significant pressure 
or potentially containing hazardous fluids. Safety is paramount as the failure of such 
as a piece of equipment can be disastrous. Failure of a pressure vessel can cause 
significant damage and lead to loss of life. Aspect Pressure Vessel is used to 
ensure correct calculations are performed, according to recognized standards, to 
ensure that the design of the pressure vessel is safe.  

Which industries are supported by the use of the software?  

Aspect Pressure Vessel is used in many industries. Aspect Pressure Vessel can 
help ensure the containment is fit for purpose in any industry where a fluid is stored 
in a vessel.

3 octave.com



4 octave.com4 octave.com

What are the major features of the software?  

Aspect Pressure Vessel features include:  

•	 A graphical user interface allowing you to add model data while seeing the vessel 
elements as they are added  

•	 Horizontal and vertical vessels consisting of cylinders, conical sections and body 
flanges, as well as elliptical, torispherical, hemispherical, conical and flat heads  

•	 Saddle supports for horizontal vessels  

•	 Leg and skirt support at any location for vertical vessels  

•	 Extensive online help  

•	 Deadweight calculation from vessel details such as nozzles, lugs, rings, trays, 
insulation, packing and lining  

•	 Wall thickness calculations for internal and external pressure according to the rules 
of ASME Section VIII Divisions 1 and 2, PD 5500, EN-13445 and AD 2000.  

•	 Stiffener ring evaluation for external pressure  

•	 Wind and seismic data using the American Society of Civil Engineers (ASCE) 
standard, the Uniform Building Code (UBC), the National (Canadian) Building Code, 
India standards, as well as British, Mexican, Australian, Japanese and European 
standards  

•	 A user-defined unit system  

•	 A complete examination of vessel structural loads, combining the effects of pressure, 
dead weight and live loads in the empty, operating and hydrotest conditions  

•	 Logic automatically increases wall thickness to satisfy pressure and structural loads 
requirements and introduces stiffener rings to address external pressure rules  

•	 Structural load evaluation in terms of both tensile and compressive stress ratios to 
the allowable limits  

•	 Detailed analysis of nozzles, flanges and base rings  

•	 Material libraries for all four design standards. ASME material libraries include 
customary and metric tables, as Section II, Part D provides. Japanese material 
libraries are also included.  

•	 Component libraries containing pipe diameter and wall thickness, ANSI B16.5 flange 
pressure vs. temperature charts, and section properties for AISC, British, Indian, 
Japanese, Korean, Australian and South African structural shapes  

•	 Thorough and complete printed analysis reports, with definable headings on each 
page. Comments and additions may be inserted at any point in the output 
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Installation

What are the hardware and software 
requirements?
Refer to the link Aspect Pressure Vessel software 
recommendations 

Does Aspect Pressure Vessel require a 
specific version of the Windows 
operating system?  
Refer to the link Compatibility Matrix

Select product Aspect Pressure Vessel and select 
the version from the dropdown to view its 
requirements. 

In what languages is the software 
available?
The program interface is available in English, French, 
Portuguese, Italian and Spanish. The Input echo report 
is available in these same languages, plus German. 

Does Aspect Pressure Vessel work on 
Linux or Mac OS?
No.

Does Does Aspect Pressure Vessel work 
on 32 and 64-bit platforms? 

64-bit Windows platforms only are supported. 

Is it possible to install Aspect Pressure 
Vessel silently? 

Yes, see the Aspect Pressure Vessel product 
installation instructions available online. https://docs.
hexagonppm.com

Can Aspect Pressure Vessel be installed 
on several computers? 

Aspect Pressure Vessel can be installed on as many 
computers/workstations as needed. Concurrent 
access and use of the software is controlled by 
Octave Licensing. 

If only a single license of a Aspect 
Pressure Vessel product is bought, can 
this be used on more than one computer?  

Yes, but only one license can be used at any one time. 

Are Aspect Pressure Vessel licenses 
named user? 

No, Aspect Pressure Vessel licenses can be used by 
any user, maximizing license use. 

Can new and old versions of Aspect 
Pressure Vessel be run in parallel on the 
same computer? 
Yes, and many customers do this. To switch between 
versions seamlessly, run the program as an 
administrator. It will help Windows point to the correct 
registry keys. 

Is Aspect Pressure Vessel backward 
compatible? 

No, analysis models can be opened only in the version 
of Aspect Pressure Vessel originally used to create 
them and later versions of the software. 

Is Aspect Pressure Vessel forwards 
compatible? 

Yes. Older files can be brought into the newest version 
of Aspect Pressure Vessel. 

Can Aspect Pressure Vessel be installed 
on a virtualized system? 
Yes, providing the system offers the required 
resources and meets the minimum software and 
hardware requirements Aspect Pressure Vessel needs 
to work efficiently.  

Note: Octave does not officially support use of Aspect 
Pressure Vessel on virtualized systems.

.

https://docs.hexagonppm.com/r/en-US/PV-Elite-Quick-Start/Version-24/378332
https://docs.hexagonppm.com/r/en-US/PV-Elite-Quick-Start/Version-24/378332
https://compatibilitymatrix.hexagonali.com/Reports/Version
https://docs.hexagonppm.com
https://docs.hexagonppm.com
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How is Aspect Pressure Vessel licensed? 

All Octave products, Aspect Pressure Vessel, included, 
are licensed by Octave’s cloud-based licensing 
solution – Octave Licensing 

Octave Licensing Client and a Configuration 
Connection Information (.CCI) file are installed on each 
workstation that needs to access licenses in the cloud. 
The Configuration Connection Information (.CCI) file 
provides a handshake between the software product, 
Octave Licensing Client, and the cloud licensing 
server, enabling licenses to be requested and returned 
by software users when they start or exit the software 
product(s) they are using.  

The first .CCI file issued to a new customer is usually 
named ‘Site ID.CCI’, e.g., 00123456.CCI. This file is 
generated for a site-based Keystore, i.e., a Keystore 
containing all licenses of all products purchased. If 
product licenses need to be deployed differently, for 
example, some of the total licenses for various 
products held by the customer need to be allocated 
for use on a specific project; then a project-based 
configuration must be created in the Licensing Portal.  

Doing so results in additional keystores being created 
and two or more CCI files being used to access 
licenses in the cloud.  

Consult online help for further information 
about Octave Licensing.
Refer to the link https://docs.hexagonppm.com

What license options exist for Aspect 
Pressure Vessel? 

Aspect Pressure Vessel licenses are ‘CX’ type, 
meaning they can be used 24 hours per day / 7 days 
per week / 365 days per year. For further information 
about this and other license types supplied by Octave, 
refer to the End User License Agreement (EULA) 
included with the software installation media. 

How are Aspect Pressure Vessel 
licenses administered? 

Octave Licensing works in parallel with the Licensing 
Portal. This is an online self-service system that IT 
personnel/license administrators can use to manage 
the configuration and deployment of their Octave 
product licenses. Customers are encouraged to use 
Octave Licensing Portal to self-manage their licenses. 
Online help covering license administration is provided 
inside the portal

Is an Internet connection required to use 
Aspect Pressure Vessel?  

Octave Licensing is cloud-based, so, an Internet 
connection is always needed to access licenses in the 
cloud when using a computer in the office connected 
to the company’s network. The exception is when 
licenses are to be used remotely, away from the office. 
Licenses temporarily checked-out to a mobile 
computer will work without an Internet connection.  

Can Aspect Pressure Vessel be used 
outside the office on a mobile computer?  

Yes, providing Offline Availability has been set on the 
licenses in Licensing Portal. Offline Availability is what 
controls license check-out via the Octave Licensing 
Client. This Octave Licensing feature is configured 
inside the Licensing Portal.  

When the Octave Licensing  Client is installed, if Offline 
Availability has been configured, it’s possible to use 
the Check-out option to check out one or more 
product licenses so that they can be used on a mobile 
computer. The licenses (product tags) available to 
check out are displayed on the ‘Check-out’ tab.  

Note: Offline Availability is not set by default on site-
based configurations; your IT administrator/license 
administrator must enable this before licenses can be 
checked out and used on mobile computers. 

Check-in is used to return licenses to the cloud license 
server when the mobile computer is returned to the 
office and connected to the network when it has 
Internet access. 

Licensing

https://docs.hexagonppm.com
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While checking out, licenses active on a roaming 
computer are unavailable for office-based users to use. 
They become available again when the licenses are 
checked in.

Can license usage be reported?
Yes, license usage reporting is available inside the 
Licensing Portal. Reporting enables IT administrators/
license administrators to understand how your 
organization is using licenses. Having this visibility of 
how licenses are used enables IT administrators/
license administrators to decide who is using the 
licenses, check peak license usage, understand how 
to optimize the use of licenses, identify if additional 
licenses are required, etc. 

Purchasing

What purchase options are available?
Perpetual licenses with or without maintenance, or 
lease licenses (minimum 3-month term) including 
maintenance, can be bought.

How is Aspect Pressure Vessel bought? 

Aspect Pressure Vessel may be bought through our 
reseller network and direct from Octave. To find your 
local Octave sales office or reseller, visit hexagon.com/
company/global-presence#

What is Octave Global Network Dealers? 

Octave Global Network Dealers are the Octave 
Standard-bearer(s) around the world. They are the 
local face of Octave. They provide product sales and 
support in your local time zone and language. These 
dealers have certified instructors and consultation 
specialists to help clients define and meet their 
requirements at all levels. The worldwide network 
dealers work together to ensure that Octave’s 
multinational clients have access to the right products, 
training, and consultation anywhere around the globe.

What is a Octave Authorized Reseller?
Authorized Resellers are the local Octave software 
experts who provide local sales and support to clients 
in their respective regions.

Is a free evaluation available for Aspect 
Pressure Vessel? 

For a free evaluation, please contact us here.

Can a live presentation be given by the local 
reseller or by Octave?
Yes, Octave and its resellers have personnel that 
provides live product presentations that answer simple 
to complex technical questions and understand project 
workflow-specific questions. For more information, 
please contact your local distributor or contact Octave.

Can an online web demo be provided?
Yes, online web demonstrations can be arranged. 
Contact Octave or your local reseller for more 
information.

Training

Is training available?
Customers receive access to free Aspect Pipe Stress 
training content via Octave University.

Are example models provided with 
Aspect Pressure Vessel? 
Yes – those can be accessed from the File tab, then 
click on the “Examples” folder. 

.

http://visit hexagon.com/company/global-presence#. 
http://visit hexagon.com/company/global-presence#. 
https://hexagon.com/company/global-presence#ol_officecountry=on
https://hexagon.com/company/global-presence#ol_officecountry=United%20States&ol_officestate=Wisconsin
https://hexagon.com/company/contact-us
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Maintenance and 
Support

What does software maintenance 
provide?
Customers receive access to free Aspect Pressure 
Vessel training content via Octave Institute. 

How do users get access to Octave 
Institute?   

Users can request access here.

Does maintenance include training? 

No, training is not part of maintenance. 

How do users request technical support? 

Maintenance customers receive technical support via 
Octave’s support system - Octave Smart Community 
(intergraph.com)

How do users get access to Octave 
Community? 

Users can request access here.

What documentation is provided with 
Aspect Pressure Vessel? 
Comprehensive product documentation for all Octave 
products, Aspect Pressure Vessel included, is supplied 
online.  

https://docs.hexagonppm.com 

Can users request enhancements be 
made to Aspect Pressure Vessel? 

Yes, everyone may submit product enhancement 
requests. Octave interacts with and listens to 
customers, then responds by developing new 
solutions and enhancing current products to address 
customers’ needs in ways that improve their work 
processes. This customer-centric focus helps us grow 
our product line to serve an ever-broader base of 
users and applications, which further increases 

opportunities for our clients to enjoy the benefits of 
interdisciplinary collaboration with other departments 
and organizations.  

To submit a new feature/function/capability request, 
login to Octave Community, click on the IDEAS tile, 
then submit your idea.  

How are the enhancement requests 
prioritized?

Enhancement requests are evaluated and prioritized 
based on a given industry and market. Octave 
prioritizes requests based on the benefit delivered to 
the highest number of our users.

Q.A./Certification
Is the software certified, and how?
The program is internally certified through thorough 
release criteria being met before the product is 
released. Quality Assurance procedures are aligned 
with ISO 9001:2015.  

The Quality Assurance Manual, which shows the 
breadth of testing with peer-reviewed, published 
benchmarks against the Aspect Pressure Vessel 
calculations, is provided with Aspect Pressure Vessel. 
Any discrepancies are explained below the table. This 
can be accessed from within Aspect Pressure Vessel 
by going to the Help tab > View > QA Manual. 

Is a Q.A. certificate provided with the 
software?

Yes. From the Help tab, go to View > QA Certificate.

https://smartsupport1.intergraph.com/userAccessRequest/
https://smartcommunity.hexagonppm.com/s/login/?language=en_US&ec=302&startURL=%2Fs%2F
https://smartcommunity.hexagonppm.com/s/login/?language=en_US&ec=302&startURL=%2Fs%2F
https://smartsupport1.intergraph.com/userAccessRequest/
https://docs.hexagonppm.com
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Key Functionality

Design Codes

What are vessel design codes included in 
Aspect Pressure Vessel? 

ASME VIII Division 1, ASME VIII Division 2 (Class 1 and 
Class 2), EN-13445, PD 5500, EN-1591, AD 2000 

What are heat exchanger design codes 
included in Aspect Pressure Vessel?
ASME UHX, TEMA, EN-13445, PD5500

Is it possible to use different / switch 
versions of design codes?  
Yes. For checking old vessels, different versions of the 
ASME design code can be selected, as can different 
versions of the ASME Material database. Design codes 
can be switched easily from the dropdown design 
code selection. Materials will need to be reselected for 
a particular design code.

What Wind and Seismic Codes are 
included?  
There are several wind and seismic codes included 
with Aspect Pressure Vessel. For the most up-to-date 
list please follow the links:  

Wind Codes: https://docs.hexagonali.com/r/en-US/
PV-Elite-Help-V25/Version-25/1267225  

Seismic Codes: https://docs.hexagonali.com/r/en-US/
PV-Elite-Help-V25/Version-25/1267227  

Does Aspect Pressure Vessel include the 
AD 2000 Code?  
Yes, Aspect Pressure Vessel now supports the AD 
2000 German pressure vessel standard.

Modeling

What are the recommended steps to 
building a heat exchanger? 
Building a heat exchanger model requires specific data 
inputs and heat exchanger-specific load cases. The 

user must be aware of these requirements. A 
knowledge base article is available, which discusses 
these in more detail. Please contact Octave and 
request the “Aspect Pressure Vessel: Designing a Heat 
Exchanger – the Pitfalls” knowledge base article.  

Also, check the examples available at Octave 
University.  

What standards apply to heat 
exchangers?  

ASME, EN13445 and TEMA.  

Does Aspect Pressure Vessel need an 
external database (Access, SQL, Oracle) 
to work?  

No. Aspect Pressure Vessel uses its file format, which 
does not require any additional databases.  

Can a user create their own units file?  

Yes. Every unit (length, temperature, pressure etc.) 
can be adjusted to the users’ requirements.

Does Aspect Pressure Vessel support 
the creation of customized materials?  

Yes. Materials can be edited or added and appear at 
the material database’s bottom. Does Aspect Pressure 
Vessel support the modelling of pipework connected 
to equipment nozzles? Yes. Connected pipework and 
the effects of that pipework can be included. 

Can TEE elements that are found in 
ASME code be included in a model?  

 No.  

Does Aspect Pressure Vessel support 
the modeling of equipment with clamped 
connections as used in the 
Pharmaceutical and Food Beverage 
industries?  

Not at present, but clamped connections are planned 
to be included in a future release. 

https://docs.hexagonali.com/r/en-US/PV-Elite-Help-V25/Version-25/1267225 
https://docs.hexagonali.com/r/en-US/PV-Elite-Help-V25/Version-25/1267225 
https://docs.hexagonali.com/r/en-US/PV-Elite-Help-V25/Version-25/1267227
https://docs.hexagonali.com/r/en-US/PV-Elite-Help-V25/Version-25/1267227
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Can rectangular vessels be modeled and 
analyzed in Aspect Pressure Vessel?  

Yes. The Aspect Pressure Vessel module CodeCalc 
includes ASME Appendix 13 for rectangular vessels.  

Design and analysis of rectangular vessels for all 
supported design codes will be included in a future 
release.  

Can rectangular or oval openings be 
created/modeled?  

Not at present, but these are planned to be included in 
a future release.  

Can rectangular vessels be modeled and 
analyzed in Aspect Pressure Vessel?  
Yes. Aspect Pressure Vessel now supports rectangular 
vessels for all supported codes. 

Analysis  

What loads can be applied to the analysis 
model?  
Temperature, Pressure, Wind Loading, Seismic 
Loading, Weight, additional forces/moments, Vortex 
Shedding.  

Are trunnions considered in vessel lift 
calculations?  
Yes, the calculation of vessel lifting can include 
trunnions.  

Does the software support creation of 
customized load cases?  
Yes. Load Cases can be configured by creating 
combinations of the loads. 

Does Aspect Pressure Vessel perform 
local stress analysis on nozzles 
according to EN 13445?  

Yes.  

 

Does Aspect Pressure Vessel perform 
fatigue analysis according to EN 13445?  
Yes. EN-13445 Section 17 Fatigue calculations are 

included.  

Does Aspect Pressure Vessel perform 
structural verification of vertical vessels 
subject to wind and earthquake 
according to EN 13445 and ASME VIII 
Div. 1?  
Yes. Wind and seismic codes are available as listed 
above, plus users can also add user-defined loads 
such as Pressure vs. Elevation for wind and Response 

Spectrum or g-loads for seismic.  

Does Aspect Pressure Vessel perform 
Transportation analysis?  

Yes.  

Does the software incorporate data for 
flanges according to ASME and EN 
standards?  
Yes, both ASME and EN standard flanges are available.

Is it possible to perform analysis 
according to API 579?  
Yes, Aspect Pressure Vessel includes API 579 ‘Fitness 
for Service’ capabilities. Aspect Pressure Vessel has 
Part 4 (General Metal Loss), Part 5 (Local thinning/
Groove Like Flaw), and Part 6 (Pitting). Levels 1 and 2 
are available in Aspect Pressure Vessel.
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Integration and 
Interoperability

Does the software integrate with Forte 
3DWorx? 
Yes. Aspect Pressure Vessel has a bi-directional 
interface with Forte 3DWorx (formerly CADWorx). 
Forte 3DWorx can both read and write a native Aspect 
Pressure Vessel file. 

Does Aspect Pressure Vessel integrate 
with Aspect Pipe Stress?
Yes, piping loads from Aspect Pipe Stress (formerly 
CAESAR II) can be imported so that they are included 
in the analysis. 

Does the software integrate with Forte 
3D? 

Yes. Aspect Pressure Vessel can export a VUE file, 
which can be processed with Smart Interop Publisher 
to create a ZVF file that can be referenced into the 
main Forte 3D (formerly Smart 3D) model.

Can the analysis model be exported to 
3D CAD format e.g., .dwg file?  

Aspect Pressure Vessel can export the vessel to a 
STEP file for 3D CAD integration. Aspect Pressure 
Vessel can also create a .dxf file.  

Which file formats can be imported into 
the software?  

Aspect Pressure Vessel can import HTRI data for heat 
exchangers to populate the information needed for 
tubesheet analysis.  

Does the software integrate with 
BricsCAD?  

Yes, a bi-directional interface is provided via Forte 
3DWorx running on BricsCAD.  

Does the software integrate with solid 
modelers, like SolidWorks and Inventor?  

Yes. Freely downloadable plugins are available from 
Octave Community, allowing a Aspect Pressure Vessel 
file to be imported and further developed to support 
the production of 2D deliverables needed for vessel 
fabrication. 

Deliverables

What outputs does the software 
produce? 
Aspect Pressure Vessel can generate detailed reports, 
including equations used in the calculations. These 
reports can be exported to Microsoft Word or PDF 
format. 

Are reports customizable? 
No, the reports are standard.

Is it possible to generate a fabrication 
drawing directly from Aspect Pressure 
Vessel? 

No. For Fabrication drawings, the vessel or heat 
exchanger model can be imported into Forte 3DWorx 
running on BricsCAD Mechanical, or the free plugins 
for Solidworks/Inventor can be used to import there. 
Once the import is complete, the functions of the 3D 
Solid Modeler can be used to generate fabrication 
drawings based on the analysis model.
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Software Upgrades

How often is a new version of Aspect Pressure Vessel released? 
Octave supplies 4 types of software release

A new major version is typically released every 12 months.  

1-2 service packs are typically supplied for each major product release, spaced roughly 6-8 months apart.  

Who has access to the latest Aspect 
Pressure Vessel upgrades?  

All users with current maintenance contracts are 
entitled to use the latest software upgrades.  

How are users informed that an Aspect 
Pressure Vessel upgrade is available?  

If ‘Subscriptions’ for each product used are configured 
inside Octave Community, maintenance customers are 
automatically notified whenever a major, minor, service 
pack or hotfix version is released.

How are Aspect Pressure Vessel 
upgrades supplied? 

Octave operates a “pull“ system for the supply of 
software upgrades; that is, major/minor upgrades are 
not shipped automatically to maintenance customers 
when the software is released; customers need to 
request upgrades themselves when they need them 
e.g., a release has a fix/enhancement that the 
customer has been waiting for.  

•	 US customers can open a service case against 
product=upgrade in Octave Community.  

•	 International customers should contact their local 
order administrator or Octave sales office.  

Online Resources  

How can customers keep informed of 
up-to-date product-related information?  

Sign up for specific solution updates via the 
Subscription Management Center to stay updated on 
the latest offerings, news, events, etc. 

Where can customers find useful 
information and other resources related 
to Aspect Pressure Vessel?  

Visit the Resource Center, then filter resources using 
the ‘Type’ drop-down.

Release Type Numbering convention
Request from your local  

Octave sales office
Download from  

ALI Smart Community

Major XX.XX.XX.XXXX Yes No

Minor XX.XX.XX.XXXX Yes No

Service Pack XX.XX.XX.XXXX No Yes

Hotfix XX.XX.XX.XXXX No Yes

https://aliconnect.hexagon.com/preferences
https://www.octave.com/learn/resources?capability=Engineering+Analysis
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About  
Octave

Octave is a leader in enterprise software, turning data into decisive 
action and intelligence into your edge. Our software solves for and 
simplifies complexity, from the design and build to operations and 
protection of people, property and assets – for any scope, at any 
scale. For decades, we’ve partnered with customers to sharpen 
performance, elevate efficiency and amplify results. From factory 
floors to entire cities, our solutions are tuned to scale up what’s 
possible from day one onward.

©2026 Intergraph Corporation and/or its affiliates. All rights reserved.
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